BT747 User Documentation

QUICK START

The most frequent usage of this software is the following:

1. Connect to the logger device

2. Download the log from the device

3. Convert the downloaded log to a tool-readable format
This is easily done with the software.

15t step

When the program starts, you are automatically on the 'Con' tab. On this tab you make the connection to your
device. When on PC, Linux or MacOS, the connection is made by using 'Connect Port Nbr'. Set the correct port
number (on MacOS, this does not matter) and click 'Connect Port Nbr'.

On a handheld device (PDA), you may need to use the 'BLUETOOTH' button. Quite often, before using that
button, you need to 'associate' or pair the Bluetooth GPS with your PDA (this is PDA dependent).

On MacOS, when using bluetooth, you may need to indicate the correct device port.

2"d step

Once connected, the software directs you to the 'Log' tab. On this tab you have a 'Get Log' button. Clicking it
downloads the log from the device. If you get an error message regarding the impossibility to open files, check
out the 'File' tab to define an appropriate directory.

3" step

Once the log has been downloaded, you can convert it by clicking one of the 'To ..." buttons. Output files are
created in the directories defined on the 'File' tab.

For more details, see further below in this documentation.

COMMAND-LINE OPTIONS

It is possible to define the path to the serial port on the command line (java execution). This will partially or
completely override any selection you may make on the connection tab in the user interface (below).

The command line options listed below are provided to the java virtual machine, which you can start from the
sample startup scripts.

-Dbt747 prefix=STRING

Sets the prefix of the port to STRING. The port number on the connection tab will be postpended to this string.
Fo example, if you launch java like this (with some other relevant options and parameters):

java —Dbt747_prefix=“/dev/ttyUSB”

And you select port 2 in the connection tab, the serial port that will be opened is ‘/dev/ttyUSB2’



-Dbt747_port=STRING

Overrides the port number and the prefix.

Example, if you launch java like this (with some other relevant options and parameters):

java —Dbt747_prefix="/dev/ttyUSB”

And you select port 2 in the connection tab, the serial port that will be opened is ‘/dev/ttyUSB’ (the 2 is
disregarded).

On MacOS X, the known port for a Holux M-241 device is to be set like this (case sensitive):
-Dbt747_port="/dev/tty. HOLUX_M-241-SPPSlave-1" .

You can also set it like this:

-Dbt747_prefix="/dev/tty. HOLUX_M-241-SPPSlave-" .

and select port 1 in the program interface.

INTERFACE DESCRIPTION

Popping up a keyboard
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This can be done on desktops by clicking F10 or F11, but it is more usefull on handheld devices.

According to the SuperWaba documentation, you can popup a keyboard in text or number fields:
/¥* abc in Palm OS, and the ALT key in Treo 600. */
/%% 123 in Palm OS or case convertion in Smartphones */

Control tab ("Con’)

This is the tab that you see when you start the application. This tab is used to control the Connection to the
GPS. Additionally, it is used to display (if available) current time and position information gathered from the
GPS in real time. As soon as you get a connection to the GPS, the application will jump to the Log tab (below).



BLUETOOTH| (Re)open port[115200 ~
Connect Port Nbr Close port

Lat:48. - Hght:51.900
Lon:2. - Time:11:33:29
Geoid:47.300(calc:47.636)

Flashinfo:C22015C2 (MX,2MB)
Model:001B (iBlue 747)
Firmware:M-core_1.94

¥1.29(25.01.2008) Logger: V1.20

This tab is used to open the connection.

“BLUETOOTH”:

Useful on a PDA like a Palm: will open a Bluetooth connection when clicking on it. Normally you get a pop up
window managed by the embedded device. On some devices, you need to associate the GPS logger with your
PDA outside the application (setting the Bluetooth key to ‘0000’ for example)).

On Pocket PC (Windows Mobile) devices, you'll need to associate the Bluetooth device with a virtual COM
port. In that case, this button is of no use (you use 'Connect Port Nbr').

“(Re)open port™:
Closes the port if it is open and opens it again.

“Connect Port Nbr” :
Will connect to the port number selected on the right (“4” in the example). The port number can be selected
from the pull down menu.

“115200”: /38400
This is used to set the baud rate. For most devices 115200 will do, but some Holux devices require 38400 (e.g.,
Holux M-241 requires 38400, while Holux M-1000 needs 115200).

“Lat”,”"Hght”,”Lon”:

Current latitude, altitude and longitude received from the GPS device (in the GPGGA NMEA string).

If no values are shown here, either reception from your device does not work or (less likely) your device does
not output the GPGGA NMEA string.

“Time”:
The time returned by the device (UTC). This can be used to adjust your camera.

“Geoid”:
height of the geoid (mean sea level) above the WGS84 ellipsoid reported by the GPS device.

“(calc:™

height of the geoid (mean sea level) calculated by the SW. This calculated value is the one used by the SW to
correct the height logged by the device in its log memory. The height logged by the device is: height above
geoid + the value mentioned next to ‘Geoid’.

The calculated value of the geoid and the one reported by the device should be similar. The calculated one
might be more precise (the difference observed in the author's area is about 0.3 meters which is negligeable).
e

“FlashlInfo:”:

A specific string returned by the serial flash indicating its manufacturer and type.

If the device is known by the SW, it will show the manufacturer and the memory size (MACRONIX and 2
megabyte in this example (=16Megabit))

If the flashinfo is shown without the manufacturer and size information, please inform the author of the program.

“Model”:
The model number as returned by the device and a guess what device you are connected to. Some 'different’
devices have the same model number.



If the model shown is 'Unknown', please notify the author.

“Firmware”:
The MTK firmware version.

“V1.29(25.01.2008)”
Information about the version of the SW discussed in this document.

“Logger: V1.20":
The SW version of the logger (not the MTK device, but the SW responsible for filling the flash on the device).

“Close port™:
Closes the serial connection — otherwise it stays open.

After connection, the application automatically jumps to the ‘Log’ tab, but when you return to the connection tab,
you’ll see some extra information gathered from your GPS

The model number, the firmware version and (depending on your device), the MainVersion will be displayed.
This corresponds to replies on the ‘PMTK604’ and ‘PMTK605’ commands.
The device identification between parentheses is an educated guess based on the model number.

Log tab

This tab is used to control the logging functionality of the GPS, to download the log from the GPS, and to
convert the downloaded log (or optionally a log downloaded by the vendor's utility) to another format such as
csv, plt, gpx, kml, nmea or gmap. The File tab also may have an effect on what happens in this tab. If you
want to delete the log on the GPS device, see the FMT (Format) tab.

[ IR IRTES
FMT|CtrILogfFileFltrEasy|/Con/Othr
[vIDevice log on{/off) gsﬂart dwnld

[ Log overwrite(/stop) when full
Date range(01/01/1983] [21/09/2008

Get Log Mo Fix Color|0000FF -
Trk sep;  60min UTCH+0
One file - haht - geoid diff

To C5V][To GPX| [To TRK]|[To KML
To PLT [To GMAP] To NMERA
Mem Used : 26402(1%)

Nbr records: 651 (54075 Free)

“Device log on(/off)” tick box

When this box is ticked, the GPS Datalogger is filling its memory with GPS information. By unticking it, the
device will stop logging until it is powered off and on again, or until it wakes up from standby mode or until you
tick this box again.

While downloading information from the device you probably are not interested in filling your device’s memory
with ‘useless’ information, so you can untick this at that time — remember to tick it ‘on’ again or to apply a ‘power
cycle’ to your device if you want logging to be active.

“Normal Download”
Will always download the reported filled memory, starting from the beginning of the log.

“Smart Download”



Usually you’ll download data from the device without subsequently erasing the log. When downloading data
from the device a second time, the ‘official application’ downloads all the data. By selecting "Smart Download"
in this application, the data already downloaded will not be downloaded again, but simply ‘appended’ to.

There is a smart checking of course: the first 512 bytes of useful data in the first block of data on the device are
downloaded and checked against the data previously downloaded. If this data is different, then the download
will start from byte 0, if it is the same, the program will look for the first series of empty data in the previously
downloaded log and start downloading from there.

This option is ‘on’ by default.

Some other stuff goes on if you activated 'overwrite' on the device: in this case the program will download all
the data.

“Full Download”
Will always download the full log even if it is only partially filled.

“Log overwrite(/stop) when full”:
When this option is ticked, the device will overwrite its internal data when it is full, if not ticked, it will stop
logging when it is full.

“Date range” dates

When clicking on a date, a popup will allow you to select another date.

The two dates determine the range of dates that will be written to the output format. The range does not limit
the amount of data downloaded from the device — all the data is downloaded.

The indicated dates are ‘inclusive’ — in order to select one date for the data output, the start date and the end
date must be the same.

By default the first date is in 1983 which is before any data that you will be able to log at this point in time, the
last date is the current date (at the time of starting the program).

“Get Log™
Starts the download of the log. The download does not block program execution.

“Cancel get”;

Stops the download of the log. It might be useful to cancel the get and start “Get Log” again if downloading
suddenly gets very slow (the error recovery mechanism may get messed up — corrections have been introduced
in the program but are difficult to ‘validate’).

When you cancel the download, it can be completed later.

“Trk sep”:

If two log records are separated by a time bigger than the time for this item, it is considered that a new track is
started with the later record. This setting is used when selecting “One file / trk”. This value is also used in the
Application Menu (below), in the "Settings > GPX Trkseg when small" setting.

“‘UTC” (+0,+1,...,-1,-2):
The time offset to apply to the written data. Example, if the UTC time in the downloaded log is 2:00, and the
requested offset is ‘+2’, then the time written in the output format will be ‘4:00’.

“No Fix Color”:
The color to use (in GMAP currently) for the line between two valid fix points when there were invalid fix points
(like when driving in a tunnel or when in a building).
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“One file”, “One file / day”, “One file/trk” pull down menu (see image above)
+ One file: all records will be written to one single file;
+ One file/day: records will be written to several files, each grouping one day;
» One file/trk: upon a track separation condition (see Trk Sep above), a new file is created for the next
track.

“hght — geoid diff”:

The height data logged in the device is the height above the geoid. What you expect (as well as Google Earth
for example) is the height above the mean sea level (MSL).

When this box is checked, the program will compute the MSL above the geoid and substract that value from the
logged height data before writing it to the output file. That way the height above the MSL is logged.

Formula: (height above MSL) = (height above geoid) — (MSL above geoid).

“To.....7
Some general comments for exporting data:
Only selected data will be exported. There are several filters that can be controlled by the user and they all limit
the data that will be written:
+ Date range;
* Fltr:
o Defines the trackpoints:
= In formats like ‘KML’, trackpoints will be used to draw the track.
= For formats like CSV, these are the points that will be written (waypoints are
ignored)
o Defines the waypoints:
= In formats like ‘KML’, waypoints will show as clickable bullets on the map with point
information popping up;
= Waypoints are ignored in formats like CSV.
* The downloaded data:
o When you abort the download, only the downloaded points can be converted.

Important Note: (see also File tab, below)

You can use this application not only to read a log file from a GPS Datalogger, but also to (re)convert an
existing logdfile to another format. For example, you may already have downloaded a log-file using the vendor-
supplied program (e.g. Holux Utility, which downloads to a .trl format), and you want to convert it to a .gpx
format. If in the File tab you specify the directory name and file name of the log file to be converted in this
screen, you can then convert it using any of the buttons mentioned below.

The application can also read a CSV file issued from this application or the original application. Again, it is the
".csv' extension that will identify the input file as a CSV file.

“To CSV” (uses the Trackpoint filter):
Export the downloaded data to CSV files (CSV=Comma Separated Value). Such a file is readable by excel and
a number of other programs.
The format is improved over the original format:
» The units are mentioned in the header only and records have numerical values only for most fields;



+ Some data transformed incorrectly in the original application is transformed correctly here;

“To TRK” (Uses the trackpoint filter):
Export to the "TRK file type of the CompeGPS application.

“To GPX” (Uses the trackpoint and the waypoint filter):
Exports the downloaded data to GPX files. The GPX format is required or understood by most applications that
use GPS data. Google Earth can also read it for example.

“To KML” (Uses the trackpoint and the waypoint filter):
Exports to KML format for Google Earth.

“To PLT” (Uses the trackpoint filter):
Exports to Ozi Explorer PLT format.

“To GMAP” (Uses the trackpoint and the waypoint filter):

Exports to HTML files that call the Google Maps API to show the points on a map (no need for Google Earth
and can be sent by mail).

Each HTML file is standalone - no need for extra files!

To be able to put it on a web site, a specific 'key' must be set in the HTML file. You can get such a key from
http://code.google.com/apis/maps/signup.html .

To get the key added to the GMAP .html file, you can create a 'gmapkey.txt' file in one of the following
directories (searched in this order):

- The 'report' directory;

- The 'lodfile' directory;

- The 'output' directory;

- The directory where the configuration file is stored (on Pocket PC, ...).

The first line of the 'gmapkey.ixt' file must be the key you got from the google maps signup page (with no other
characters added). The lines following that are ignored.

At the bottom of the web page that will be created from the html file, you will find tick boxes that allow you to
enable and disable tracks shown on the map.

“To NMEA” (Uses the trackpoint filter):

Outputs (part of) the data to standard NMEA strings. Some applications that do not understand the GPX format
do understand the NMEA strings. These strings are similar to the data sent by a generic GPS device. You can
select NMEA strings to be written in the ‘NMEA File’ tab that you can find inside the ‘Othr’ tab. That way you
can reduce the file size or make it suitable for simple text treatment.

“‘Mem used”:

Currently supposes that there is 16Mb of memory. Some devices have less memory. The amount of memory
available would need to be guessed today from the model number as the command to retrieve available
memory is unknown today.

The memory used shows the absolute amount of memory used in the GPS DatalLogger and the percentage of
useful memory used (i.e., not taking into account the block headers that can not hold GPS information).

“Nbr records”:
The number of points logged in the device.

“Progress bar”
When downloading data, a progress bar will appear. When the progress bar disappears, download either
completed or was interrupted.


http://code.google.com/apis/maps/signup.html

File tab

This tab controls where your downloaded log file will be written. Optionally, you can also specify the name of a
log file previously downloaded with a vendor utility (like the Holux Utility that writes .trl files) for conversion in the
Log tab to one of the possible external formats (e.g. gpx).

Qutput dir]/BT747 |
LogFile:log_dumps/BT747log_nov2.bit+|
Report |GPSDATA

Chunk 355536

Chunk ahead request:|3 -|
Read timeout (ms) {3500 |

Rpply&Set the above values|

Default settings

The directory separator is ‘/’ on all systems (including windows).
Settings on this tab are taken into account only when doing “Apply&Set the above values”.

“Output dir”

The base directory for all output files (and input log files).

Click on ‘+” will popup a list of directories on your system.

If you do not know where to start, erase the directory listed and click on ‘+’, you will be shown directories
starting from root.

You may need to use ‘+’ multiple times — it will add at least one extra hierarchy at a time and sometimes more.

“Log file”

The filename for the raw log data; by default it's "/BT747". If this directory does not exist, you will have to create
it, or else an error will result when you try to download the raw log data. By changing the name here you can
archive and reference all your log data. For example, you can add the date in the raw log file name.

If you prefer the data to be in a subdirectory you can add an extra level by writing for example: “rawdata/
20070708iBlue.bin”

You can use “+” to select an existing file.

Important Note:

You can use this application not only to read a log file from a GPS Datalogger, but also to (re)convert an
existing logfile to another format. For example, you may already have downloaded a log-file using the vendor-
supplied program (e.g. Holux Utility, which downloads to a .trl format), and you want to convert it to a .gpx
format. Simply specify the directory name and file name of the log file to be converted in this screen, and then
press the "To GPX" button on the Log screen. So, if the log file has a ".trl' extension, it will be interpreted as a
Holux tracklog file upon reading (while converting to one of the other formats from the log tab). If you are going
to read a raw log file from a DataLogger, do NOT specify a log filename with extension ".trl' but rather, use '.bin’,
otherwise the BT747 will get confused when you try to convert the logfile to another format.

(ﬁReport”
The base name for the exported data. A date will be added to this basename and an extension depending on
the output format.

“Chunk”:

Defines the block size requested for download.

On USB this can be a value of up to 65536.

When using bluetooth, the best setting depends very much on your host (computer/PDA). With some devices a
Chunk size of 65536 works fastest - these devices probably have a big receive buffer. On a Palm Life Drive,
the best setting was a chunk size of 220, in combination with a ‘Fix period’ of 500ms and limited ‘NMEA output’
strings.

“Chunk ahead requests”:



Defines how many requests will be pipelined. Pipelining will (should) improve performance for small chunks
(like when you use Bluetooth), and have a negative impact on performance for big chunks. Therefore, when the
chunk size is big, this value is ignored (supposed to be ‘0’);

“‘Read timeout (ms)”:
Time after which a request without response is considered as failed. A small value that is too small will result in
re-requesting data too fast. A big value may slow down communication too much in case of an error.

“‘Apply&Set the above values”
This must be click to apply the values modified on this tab. If not clicked, they will not be used.

“Default settings™:
Computes the settings as if the program was launched for the first time.

“Card/Volume”: (ON PALM DEVICES)

Allows you to access the hard disk or expansion card. “-1” indicates the last storage device on the PDA, which
is usually the expansion card and which is internal memory if there is no expansion card (or hard disk like in the
Palm Lifedrive). Cards are detected only at the start of the program.

Filter tab

On this tab you define the filters to define what are trackpoints and what are waypoints. Generally, the waypoint
filter is ignored if the output format does not distinguish between trackpoints and waypoints. In that case, only
the trackpoint filter is used.

The settings on this tab are saved to the configuration file at the end of the application.

“Trkpt | Waypt” buttons

The highlighted button indicates which filter setting type is being defined: ‘Trackpoints’ or ‘Waypoints’. By
default waypoints are defined as points with a valid fix that have been requested by the user (=Button).
‘Trackpoints’ are by default all valid points.

Format tab (‘FMT")

The Format tab defines which data will be logged on the device.
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uTC

Logs the time for the point.

VALID

Logs the validity conditions for the point. The most usefull types are:

- No fix: the GPS did not have a fix (usually the previously known position is logged);
- 2D: only a 2D fix

- 3D: a 3D fix was found;

- DGPS: DGPS data was used (WAAS, ...) to determine the location;

- Estimated mode: the fix is not perfect, an estimated positioni is logged.
LATITUDE

What it says

LONGITUDE



What it says

HEIGHT

Actually logs the height with respect to the WGS84 ellipsoid. The BT747 can correct this to geet the height with
respect to the Mean Sea Level (see elsewhere in this document).
SPEED

The speed of movement measured at the particular point.
HEADING

The measured direction of movement

DSTA

The DGPS satellite identification.

DAGE

Age of the DGPS data

PDOP, HDOP, VDOP

Positional, Horizontal and Vertical Dillution of Precision.

NSAT

Number of sattelites in view and in use

SID

Satellite ID, needed to be able to log Elevation, azimuth and SNR data.
ELEVATION

Elevation of the satellite

AZIMUTH

Azimuth of the satellite

SNR

Signal to Noise Ration of the satellite signal
RCR

ReCord Reason. Why was this particular point logged (speed, distance, time, button press, ...)
MILISECOND

Logs the miliseconds of the time (not logged with UTC alone, usefull when the fix is more than 1 Hz).
DISTANCE

The distance moed since the previous (logged?) point.

VALID PTS ONLY

Logs only points with a valid fix to the log, no points with 'no fix' are in the log - this saves memory for pts that
are not usefull anyway.

This does not work on all devices - old iBlue 747's will not allow this. If your device is a 'B_core' it will likely
work.

... records estimated

The number of GPS points that can be logged at most

This also depends on other conditions (e.g., the device logs info whan you switch it on and off, change the log
format, log conditions, ...).

Set&Erase

Set the indicated log format and erase the device. This is compatible with most other programs reading the
raw BT747 data.

Set

Set the indicated log format. This may lead to incompatibility withthe program delivered with your device that
can not handle log format changes.

Erase

Erase the log on the device without changing the log format

Filter tab ('Fltr’)

The Filter tab is used to define filters that operate on the data that is downloaded from the GPS and that gets
written to a local lodfile.
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Standard Filter sub-tab
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The standard filter operates on two kinds of information:
+ Fix information
» Log reason

If the data on which the filter would operate is not logged, the selection condition is considered true. The filter
will still operate on the logged points that have the relevant data.

Fix information

The fix information indicates what kind of fix was reached for the logged point:

- No fix: There was no fix for the point. There may be time information and satellite information available. In
general a user is not interested in ‘no fix’ points, so this is inactive by default;

- SPS: Standard Position Service ;*

- DGPS: Differential ... Position Service;

- PPS: Precise Positioning Service (= Military — will probably not occur);

- RTK: Will likely not occur

- FRTK: Will likely not occur

- Estimate: The position is not precise, it is an estimate : does happen! You might want to unselect this.
- Manual: Will likely not occur (added for completeness)

- Sim: Simulation Will likely not occur (added for completeness)

Log reason

The log reason indicates why the point was logged. This is related to the settings on the control tab.

A log point can have multiple log reasons. If the log reason is not recorded in the log, the reason is supposed
to be 'Time'. This means that you can mix log sessions where your log the log reason and where you do not log
the reason while maintaining the capability to log 'Button' points only.

If the checkbox next to a log reason is ticked, any log point that has been logged for that reason will selected for
the point type.

- Time: The item was logged because the specified time had expired, or because the log reason is unknown;
- Speed: The item was logged because the measure speed was above the required speed;

- Distance: The item was logged because the distance condition was reached;

- Button: The item was logged because the user pushed the log button.

- App...: The item was logged because the user requested an application specific reason (see “Easy”).
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Advanced Filter sub-tab
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SET|CLERR IRETIVENINACTIVE

The advanced filter must be activated (through the ACTIVE/INACTIVE buttons), and it operates on types of
information not used by the standard filter. Activating the Advanced filter on a PDA could result in longer
treatment times for the different output files.

Any value of '0' indicates that the particular constraint is to be ignored. All conditions are grouped in an AND
function, i.e., they must all be true for a record to be transcribed to the output. At the same time, the Standard
filter must succeed too.

“record Nbr”; specifies the range of records to keep in the output. You could use this to select
subranges of the data based on the record number.

“speed”: specifies the range for the records with a given speed to keep. If the speed is not logged, the
specific record is selected.

“distance”: specifies the range for the 'distance’ field of a record.

PDOP, HDOP, VDOP: Could be used to select records that are precise enough for your application
(See "Dilution of precision" on Wikipedia)

NSAT: Minimum number of satellites in use

Format Filter sub-tab

B
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This looks very much the same as the main 'FMT' tab but it serves a different purpose.
It selects the fields that will be written to the output file (during conversion) in some form. This way the output
file size can be reduced dramatically.

"TRK PT INFO" enables or disables the writing of information for each track point in certain output formats. In
KML for example a text can be associated with each track point, something you may want to do only with
waypoints.
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"TRK PT NAME" enables or disables the association of a name with the trackpoint. When enabled, the
trackpoint entry can have the record number associated with it.

Control tab (‘Ctrl’)

This tab is used to query, and optionally set, how often the GPS will write to the log.

_Ioj x|
e 747/757 / BT-Q1000
FMT|CErlLogfFile]Fitr[Easy|Con[Othr
[Time (s)
[ISpeed (km/h) ]
[IDistance (m)[ ]
[VIFix (ms)[500 |
[VISBAS[WARS -] [incl. Test SBAS

SET

When you enter this tab, the application will request the current status from the device. You can then change
the values and send them back to the GPS. This can be quite useful with GPS units like the Holux M-241,
which only provide a limited menu of possible settings in the vendor-supplied application or the on-board
menus; this application will allow you to set other values in the GPS.

“Time”

The time period at which GPS data will be logged (if active). For example, a value of 8 will log GPS data every
8 seconds.

The time period can be fractional. A value of ‘0.2’ will log the data every 200 ms. That would correspond to a
frequency of 5Hz. If the fix frequency is also 5Hz, then you have 5Hz logging.

The Holux M-241 (and the Holux Utility) on-board menu will only allow time periods of 5, 10, 15, 30, 60, 120
seconds, but this application will allow you to set other values, e.g. 1 second, or 2 seconds, or 17 seconds.
“Speed”

If the speed is higher than the speed you set here, the gps fix data will be logged (this could be useful for
logging speeding by an automobile, or auto-logging by an aircraft - set the speed to the stall speed of the
aircraft). Logging occurs for each ‘fix’ that satisfies the condition. If your fix frequency is 5Hz then up to 5 points
may be logged per second.

“Distance”

As soon as the distance from the previously logged point is higher than the distance here, then the point will be
logged. Again, this test is performed for each fix. If you are in an airplane flying at 800 km/h, the speed is 222
m/s. If the fix frequency is set to 5Hz, you would log one point every 200 ms (=every 133 meters).

“Fix”

You can set the fix period here. By default it is 1000 ms (1Hz), you can set it to any value above 200ms.
“SBAS”

Select the type of DGPS information you want to use. The only useful settings are ‘No DGPS'’ to deactivate
DGPS or WAAS. The WAAS setting includes EGNOS (European system).

RTCM requires data not being sent by the satellites so this is a feature of the MTK chipset for more advanced
uses.

“Incl. Test SBAS”

The EGNOS system is not officially deployed yet. By ticking this box, you’ll activate the usage of the satellites in
test. In that case, precision is not guaranteed.

“WGS84” (or TOKYO...)

This indicates the DATUM used and is generally WGS84.

“Set”

Clicking on this button will send the settings to the device. The new status is requested from the device — any
setting that was unsuccessful can be detected this way.
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Easy tab

Easy control of some of the GPS device functionality.

=101
BT747 - MTK Logger Control
FMT|CtrllLogFile[Fltr|Easy|Con|Othr

[Store settings] Restore settings|
Hot start] [Warm start] [Cold start
Factory reset Forced erase
Click to log a point with reason:

Time| App1 App5 App9|

Speed|  |[App2 App6 AppX
Distance| [App3 App7 AppY
Button| |App4 App8 AppZ

“5Hz fix + log”

Sets 5Hz fixing and logging by the click of one button. You can observe the changes in the ‘control’ tab.
“2Hz fix (avoid static nav)”

The author thinks that setting the fix frequency to 2Hz, the "static navigation" "feature” does not work. Clicking
on this button does just that — no need to know what value you need to set on the ‘control’ tab.

“Store settings”

Store the current settings of the logger on the computer/PDA.

The settings concerned are:

- Time, Distance and Speed log conditions;

- The log format;

- The fix period;

- The SBAS settings ( (in)active, type, include test satellites);

- Log overwrite or log stop;

- NMEA output settings.

These settings are lost by the device when it looses power (e.g., when you change the battery or when the
battery is empty).

By saving them on the computer or PDA, you can restore the settings on the device with one click in stead of
setting all the options again.

This button is unavailable untill the SW has retrieved all the required settings from the device which can take a
few seconds.

“‘Restore settings”
Restores previously saved settings to the device.
This button is unavailable until you saved some settings at least once.

“Hot start”

Reuse stored satellite information. If the data is current, the fix can be fast.

“Warm start”

Reuse stored almanac information.

“Cold start”

Do not use any stored information.

“Factory reset”

Performs a factory reset and a cold start of the device. The precise effect of this command is unknown and
untested by the author. Use at your own risk (like any other function of this program, but this one is particularly
risky).

“Forced erase”

Under some conditions the Flash Memory of the logger gets corrupted and some 'sectors' become unusable
according to the logger.
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By clicking this button, you can try to recover from this situation. Basically, the logger will forget that some
sectors were unusable according to previous observations and the log will be erased.

“Time”, “Speed”, “Distance”, “Button”:

Record a position on the device with as log reason the one indicated. These log reasons are the ones that can
be logged by the device in an autonomous way.

“App...":

Log a position on the device with an application specific reason. For example, you could choose App1 if you
find a lot of fish at a location, App2 if you find a lot of birds at a location. [Currently these reasons are not

transcribed in any of the output formats, but you can use them as a filter reason already.

Other tab ('Othr’)

This tab contains other less commonly used features, grouped in a number of sub-tabs.

Flash sub-tab (‘Fish’)

Read-only display of some options on the GPS device.

=101 x|

i-Blue 747 /7757 / BT-Q1000
FMT|CtrlLogfFile[Fltr[Easy|Con/Othr

[Fish|NMER Output[NMER File]

TimesLeft|0
Update Rate (Hz)
Baud Rate|115200

GLL Per|0 RMC Per|1
VTG Per|0 GSA Per|1

GSV Per|1 GGA Per|1
ZDA Per|0 MCHN Per|0
SET

This tab simply reflects the settings programmed in the flash of the GPS device. This was added on request of
a user who thought that these settings could be reprogrammed.

As the value ‘TimesLeft' reads ‘0, this indicates that the values can not be reprogrammed to flash
(=permanently). They can however be reprogrammed dynamically (i.e., when removing the battery, dynamic
settings are lost). To change the settings dynamically, look at other places in the program interface.

- Update rate (Hz): Default fix rate of the device.

- Baud rate: serial communication speed. This setting should not be changed as this is the baud rate internally
on the device: between the GPS chip and the USB chip, between the GPS chip and the BT chip. It does not
define the USB or BT speed directly. Changing this setting will likely make 'brick’ the device (i.e. turnitinto a
non-functional 'brick').

- GLL, VTG, GSV, ZDA, RMC, GSA, GGA, MCHN Per = The default periods of these standard NMEA
sentences. The period is expressed in terms of fix periods. If the fix frequency is 5Hz, then the fix period is
200ms. Therefore, if the ZDA period would be 3, then the ZDA sentence would be sent every 600 ms. The
default periods are 1 and 0 generally.

HSETYI
The settings can be changed if TimesLeft is a value other than 0. But note that his function is untested and

could result in a malfunction of your device. The program does not allow you to change the baud rate as this
would most certainly break your device.

‘NMEA output’ sub-tab

Fine-grained control of the NMEA sentences. Use at your own risk.
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[FMTICtrlLogfFilelFitr[Easy|ConfOthr
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There is some similarity with the ‘Flash’ tab: the periods of the sentences are mentioned again. Only this time
there are more sentences and the periods are configurable. The settings here will be kept until the device loses
power (battery removed or empty), when it is in the off position, the values are still kept.

Be careful to have at least one regular sentence set to a value other than 0, otherwise the Bluetooth connection
will no longer work. If you set all values to 0 by accident, then you either need to configure the device by using
the USB interface or you can simply remove the battery and put it back in place again (you will lose some of the
other settings too).

The MDBG sentence is not regular (or not activated), while the ZDA string is a regular one.
For documentation, look on the internet.

‘NMEA File’ sub-tab

On this tab you can select the NMEA strings that will be written to the NMEA file when converting the log.

[ =
BT747 - MTK Logger Control

FMT[CtrllLoglFile[Fitr|Easy|Con|Othr

FIShNMEA OutputNMER File[Holux]

LTI [T

-~ )
)
fmu ]

Some of the types are grayed out as they are not available for this output format (yet).

Some applications only need ‘RMC’, so selecting just this reduces the file size while being often quite sufficient.
By selecting one NMEA string type, it is also easier to treat the data in scripts or in tabulated software such as
Excel.

‘Holux’ sub-tab
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[ B (0|

BT747 - MTK Logger Control
FMT|CtrlLoglFile[Fltr|Easy|Con/Othr

FIshNMER Output{NMER FileHolux|

Holux Name| |
SET

BT Mac Addr:[FF:FF:FF:FF-FF:FF |
SET

On this tab you find some information and settings related to specific Holux devices only.

“Holux Name”:

Some Holux devices (M-241, GR-241, ..., not the Holux M-1000), can be given a name that is most likely visible
on the LCD screen of the device.

This text field will initially show the name retrieved from the device. You can change it and then click SET to
send it to the device.

BT Mac Addr

The mac address for the bluetooth interface - this is the devices' 'network HW address'. Might apply to other
devices. After reloading the firmware on a Holux M241 device, the reprogrammin gof the MAC address might
go wrong and the address will shoz 'FF:FF:FF:FF:FF:FF'. You could change it to the address you want and
click SET just below.

Application Menu

(click on the title bar at the top of the application window to see this menu)

=101 x|

Settings Info
Exit application|rEasy|Con/Othr|
[ [Time (s)

[Speed (km/h)] |

[ Distance (m)] |

[VIFix (ms)500 |
[ISBAS[WAAS -] L Jincl. Test SBAS

SET

“File -> Exit application”
Exits the application in a clean way. You will get some confirmation windows.
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| i
File Device Info
FMT]|Stop connection
FishNStop log on connect
HoluxGPX UTC offset 0

GPX Trkseqg when small v
GPS5 Decode active v
Record nbr info in logs
Focus Highlight

Debug

Debug conn.

Stats

Imperial Units

Output log conditions

BT M

“Stop connection”
Stops the connection.

“Stop log on connect”

Some users want to prevent that the loggers continues to fill the memory as soon as their desktop connects to
it. This makes some sense in that the place where your deskop resides is probablynot something the memory
needs to be filled with.

When this option is active, as soon as a connection is made with the device, the device is instructed to stop
logging.

A small word of warning: the logging is not actived again on disconnect. You need to either reactive it (Log tab)
or perform an on/off cycle on your device.

“Stats”
Logs statistics concerning file download. Currently it does nothing.

“‘GPX UTC offset 0"
In principle the GPX output should always have UTC time. By checking this option, the UTC offset request is
always ignored for the GPX format.

“GPX Trkseg when small”

By default a track separation is done in the GPX file if 'record' are not selected in between two records.
Activating this option will not make this separation for records where the time difference is smaller than the one
specified in the 'Trk sep' option.

“GPX Decode Active”

this activates the decoding of the GPRMC and GPGGA NMEA strings which results in more processing power
needed by the program. When decode is active, the current location and time are available on the location tab
(information reported by the GPS device).

“Record nbr info in logs”
By default the output formats will record the record (=index) number of the position in the log. This takes up
place in the output file. To get smaller files, you can deactivate this feature by activating this option.

"Focus Highlight"

On penless devices, highlights the element currently selected. Usefull for penless devices, but annoying on
other platforms.

This should be disabled by default on a PC and on Palm devices, but active on other devices. This setting is
saved so you can enable or disable it only once and keep the setting.

“Debug!!
Activate debugging functionality — extra messages will be sent to the console or a file on your device.

On PocketPC, look for 'My Device/SuperWaba/BT747/DebugConsole’.
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On Palm, look in the Memos.
On PC, Linux, make sure the console is started.

“Debug conn.”
Activate debugging functionality — all communcation on the serial link is logged to a file called
'‘gpsRawDebug.txt' containing raw connection transactions with time stamps.

This is complementary to the previous option.

“Stats”
Not used yet - intended to activate statistics.

“Imperial units”
Will use inches, mph, etc. where possible.

“Output log conditions”
Write to certain output formats (e.g., CSV) what the log trigger conditions were at a certain moment.

B o]
File Settings Info
FMT|Ctrl|[Default Device v
FishNMERITrackU-Nemerix

Holux NafiTrackU-PhotoTrackr
iTrackU-SIRFII

Holux M241
BT Mac AuorFrrrFrFrrrrr

SET

Force the device type selection

“Default device”
Use the default device type for GPS device communication. This concerns most MTK based loggers/devices.
A Holux M-241 is recognized too - the "Holux M241" option may be needed to correctly recognize the log file.

“iTrackU-...”
Select the corresponding device types. The functionality for these devices has never been confirmed by a user.

“Holux 241~
For the interpretation of the 'bin' file as a Holux M-241 log.

“Info -> About BT747”

Information about the application and application version in the window title.
Build date and time in the window content.

Email address of the author.

“Info -> About SuperWaba VM”
Information about the SuperWaba Virtual machine

“Info -> Info”
Disclaimer and license reference.
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GOOGLE EARTH TROUBLESHOOTING

When you have exported data and you are reading it in Google Earth, you may be wondering why you do not
see the data.

If you do not see the data, check the date range shown by Google Earth (there is a timeline with a start ‘bar’
and end ‘bar"). Also check if the waypoint and trackpoint data is activated. Further, some track are only visible if
you zoom in enough. If you still can’t seen anything, check if there are points in the output file that was written.
If there are not enough points according to you, check the ‘Filter’ tab and check all the items to ensure that
everything is written to the output log.

Postscript

The program described in this documentation can be downloaded from sourceforge.net/projects/bt747 .

This document is available at docs.google.com (copy and paste the link if clicking on it does not work
http://docs.google.com/Doc?id=dcgzhqdv_9gsd7mbfk).

Download the PDF format at docs.google.com (copy and paste the link, click does not work
http://docs.google.com/View?docID=dcgzhqdv_9gsd7mbfk&revision=_latest&format=pdf).

The program is subject the GPL License (for further information, see the files (README, LICENSE) delivered
with the software).

Contributors to this documentation:
Mario De Weerd
Stewart Midwinter

You can participate by writing to Mario De Weerd - The e-mail can be found in the "About" of the application.

PROGRAM UPDATES

You can be informed about updates to this program by following this link. .

Final word

Freeware and open source can only exist if everybody participates.

If you take something, give something back to the community. You do not need to be a programmer to be able
to do so. You could improve this documentation, improve the web site, share your experience on the forums,
etc . Think about it!
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